
HANDBOOK FOR CONDUCTING COMMUTER PATTERNS AND 

BEHAVIOR ANALYSIS 

 

SUMMARY 

 

The University at Albany conducted an extensive eighteen month study of its commuting population.  This was 

made possible through funding provided by the New York State Energy and Research Development Authority and 

the New York State Department of Transportation.  This handbook serves as a series of tutorials highlighting the 

steps that should be considered when recreating similar transportation studies.  The transportation issues at the 

University at Albany are not unique and are shared by many throughout the state of New York and the country as a 

whole.  The goal of this project is not only to address the transportation and commuting environment at the 

University at Albany, but to also serve as a model for other universities and institutions that would like to perform 

similar studies.  The handbook addresses the methodology for conducting similar GIS studies, a step by step run 

through of the processes involved in an on-time performance study, along with a series of suggestions to maximize 

the amount of knowledge gained from survey and focus group efforts.  By offering a framework for an unlimited 

number of institutions to conduct similar studies, it is hoped that this handbook can lead to a vast decrease in 

greenhouse gas emissions, while improving the quality of life for countless commuters. 

 

 

 

 



 

TUTORIAL FOR GIS ANALYSIS  

 

 

INTRODUCTION 

 

The purpose of this tutorial is to provide a synopsis on performing a GIS analysis on regional commuter data.  These 

GIS techniques are an essential tool that allows analysis of commuting patterns to identify areas of high need within 

a region. 

 

OBTAINING DATA 

 

Commuters are broken down into two segments: 1) density of commuters by postal boundary (zip code), and 2) 

geocode of commuter permanent addresses in relation to metropolitan mass transit authority‟s bus routes.  A crucial 

element to any study is reliable data.  When commuters are issued parking permits, this data should include their 

home addresses thus allowing for the creation of a database for GIS analysis.  If an institution is not currently 

requiring parking passes to park at a location, other sources such as payroll, student accounts, etc. may have address 

information available.  

 

The GIS layers that were needed to complete our project were obtained from these listed sources: 

 National Atlas 

o URL:  http://www.nationalatlas.gov/maplayers.html?openChapters=#chpbound  

o Data:  State Boundaries 

 New York State Office of Cyber Security and Critical Infrastructure Coordination 

o URL: http://www.nysgis.state.ny.us/gisdata/inventories/member.cfm?organizationID=522  

o Data:  NYS County Boundaries – 1:24,000, NYS Civil Boundaries, NYS Zip Codes, NYS Streets 

 Capital District Transportation Authority 

o URL:  http://www.nysgis.state.ny.us/gisdata/inventories/member.cfm?organizationID=98  

o Data:  CDTA Bus Routes (October 2009), CDTA Bus Stops (November 2009) 

 

After obtaining the commuter data from the parking authority, or from your available data source, additional 

filtering is sometimes needed.  The research team chose to extract the data to Microsoft Excel 2007 where the 

filtering was performed. The clean data was then ready for the GIS analysis and broken down into relevant 

commuter groups based on the premise their anticipated commuting behaviors.  For example, a university may 

choose to have a separate group for faculty, another for staff and a third for students.  



 

 

GEOCODING AND PROJECTING THE COMMUTER PERMANENT ADDRESS DATA 

 

The process of geocoding is defined as assigning spatial locations to data that are in tabular form (data) but have 

fields that describe their locations.  Data was reviewed and filtered for consistency.  A dBASE table was created 

with the following attributes:  postal code, address 1, address 2, city, and state.  An Address Locator was developed 

using the ArcCatalog with the state streets shapefile.  A formatted spreadsheet was imported into the Address 

Locator to geocode the permit data.  A single re-match was performed to identify additional matches, returning 

results that remained unchanged.  All tied values were matched with an appropriate candidate along the street 

segment that was most common. 

 

GIS data can be managed in multiple formats, using any of the various selections of programs that are available on 

the market.  This methodology employs a shapefile format, along with ESRI ArcGIS 9.3 software.  It is crucial to 

project GIS data correctly.  Projecting data is the process of transforming the spatial relationship of features on the 

Earth‟s surface to a flat map.  The projection of data is dependent on the location of your study.  For example, a 

study in Albany, New York, would project GIS data in Universal Transverse Mercator grid system (UTM) NAD 

1983 Zone 18 using the ArcGIS Project tool.    The projection option can be found within the ArcMap program‟s 

advanced toolbox.  The projection will ask for your Input Dataset, which will be the permit data.  The Input 

Coordinate System option should be blank as there is no coordinate system that is currently associated with the 

permit data.  The Output Dataset, which will be your permit data projected on the coordinate system that is chosen 

should be named in a way that will make it easily identifiable.  After choosing the right Output Coordinate System 

for your location, leave the Geographic Transformation option empty, and press OK.   

 

 

A dialogue box will then appear indicating the progress of the projection.  Once completed a new layer representing 

your projected permit data will appear in the Table of Contents of ArcMap.  This layer, when turned on with the 

other layers representing the Counties/ Postal Codes, will visualize the addresses of the commuting population. 

 

 



 

 

REPRESENTING DENSITY BY POSTAL BOUNDARY 

 

To represent the density of commuters, cross-tabulations were made for each of the commuter groups by postal 

boundary and count.  Postal codes with extensions (e.g. 12202-1123) were truncated to five digits.  A dBASE table 

consisting of the cross-tab results was exported from Microsoft Excel 2007 and added to the ArcMap project.  The 

dBASE table was joined to the state postal boundary shapefile based on the 5 digit postal value (unique identifier).  

All values from the dBASE table were joined with 0% omitted from the dataset.  The joined shapefile was exported 

and then re-inserted into the project.   

 

Symbology was created to illustrate the various density values of each of the state‟s postal boundary.  To create the 

symbology you must either double click on the data layer or right-click on “properties”.  Once the “Layer 

Properties” dialogue box appears, click on the “symbology” option.  The following screen is displayed: 

 

 

 

Next Select “Symbology”, and then select “Charts” then “Stacked”.  Choose a color scheme that is representative of 

the data.  We represented the density using different shades of red.  The darkest red represents the postal code with 

the greatest density of students.  Once a color scheme is selected, click “Apply” to visualize the data on the map. 

 

This process was replicated for each commuter group.  The symbology remained consistent (modified Natural 

Breaks: 1-10, 11-50, 51-100, 101-300, 301 <).  The research teams chose to do an additional analysis for addresses 

within a sixty-mile scope of the uptown campus, which focused on the highest density postal boundaries.  These 

decisions to perform additional analyses should be made as your results progress. 

 

INCLUDING BUS STOPS AND ROUTES 

 



To identify the areas where there was a large population of commuters not being serviced by public transportation, 

the metropolitan mass transit routes were overlaid on the GIS database.  These routes were obtained from the state 

GIS Clearinghouse 

 

The bus stop shapefile  was imported into the ArcMap project and a 0.25 mile radius buffer was created for each.  

Transportation studies have suggested that 0.25 miles is an ideal distance for an individual to walk in order to reach 

a bus stop; and thus it was used for this analysis (Fairfax County Planning Commission).  Table 7-1 indicates the 

standards for distance from a bus stop that other municipalities have upheld in previous studies. 

 

Table 8-1: Tolerable Walking Distance from Bus Stop by Region/Government Entity 

  

[Maryland] Mass Transit Administration 1500 ft. (0.28 mi.) 

[Kansas City, Missouri] Mid-America Regional Council 1500 ft. (0.28 mi.) 

[New Jersey] New Jersey Transit 0.25 – 0.5 mi. 

[Ontario, Canada] Ontario Ministry of Transportation 0.25 mi. 

[NY, CT, NJ, Tri-metro] Regional Plan Association 1000 ft. (0.19 mi.) 

[Snohomish City, Washington] Snohomish County Transportation 

Authority 

1000 ft (0.19 mi.) 

Source: http://www.fairfaxcounty.gov/planning/tod_docs/walking_distance_abstracts.pdf 

 

It is important to determine the specific area of focus for each section of the study.  While some of the GIS analysis 

included permit data from all over the state, and some out-of-state communities, there was a need to focus on a core 

area for certain sections of our study.  The closest and most highly populated with commuters relevant to the study 

were recognized as the “core” counties the study.  Permits registered outside the core county boundaries were 

excluded from the bus stop portion of the study.  Addresses plotted within a buffer polygon were selected and 

recorded in tabular form.   
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TUTORIAL FOR GPS DATA COLLECTION, POST PROCESSING AND 

VISUALIZATION IN ARCGIS 

 

INTRODUCTION 

 

The purpose of this tutorial is to provide guidance for conducting data visualization and analysis in ArcGIS with 

primary data collected from a handheld GPS unit.  The ability to collect primary spatial data in the field and 

visualize the data in a GIS environment in order to conduct spatial analysis is a powerful analytical capability that 

has numerous applications.  As such, this tutorial provides detailed instructions on all stages of the process from 

operating the GPS unit in the field, collecting GPS data, post processing GPS data and importing GPS data into 

ArcGIS for visualization and spatial analysis.  This tutorial also provides instructions on how to conduct an on-time 

performance analysis of transit operations.   

 

CONFIGURING THE GPS UNITS 

 

The model of the GPS unit used in this tutorial is the 747 A+ 66-chanel GPS Trip Recorder.  This model has the 

capability to record a maximum of 125,000 waypoints.  The GPS unit automatically logs points at a predetermined 

interval by the user as well as manually by pressing the center button.  It is important to understand how to operate 

the GPS unit before primary data collection can occur in the field.  Figure 8-1 provides a graphic of the A+ GPS 

Recorder and describes the functions of the unit‟s switches and buttons.   

 

Figure 8-1: Graphic of the A+ GPS Recorder 



 

The graphic illustrates the location and function of the indicator lights, power switch, and push button found on the 

A+ GPS Recorder.  To configure the GPS unit for primary data collection open the Phototagger Software that was 

provided with the GPS unit on the mini disc.  Follow these steps to configure the GPS unit. 

 Connect the GPS unit to the computer using the provided mini-USB cable 

 Turn on the unit by sliding the power switch to the on position 

 Click File>Configure GPS 

 The Configure GPS Module will open 

 Connection setting = Auto Scan GPS Module 

 GPS Log Setting = General 

 Log criteria = Log every 5 seconds 

 Select “Stop Log” option for when data logger memory is full 

 

 

The “Configure GPS Module” dialogue box should be calibrated as shown below: 



 

The next step in calibrating the GPS unit is to specify the coordinate system.  To specify the coordinate system: 

 On the main menu bar click Tools>Options 

 Distance unit = Imperial, Degrees 

When correctly calibrated the Options window should appear as shown below: 

 

Before the GPS unit is taken into the field for primary data collection it is a good idea to check and see if the unit‟s 

memory storage is clear.  If not, it is generally a good idea to clear the unit‟s memory in order to increase its data 

collection capabilities in the field.  To clear the unit‟s memory: Click File > Clear Device Log.  Now the GPS unit is 

ready for primary data collection in the Field. 

 

GPS DATA COLLECTION 



 

The purpose of this tutorial is to provide detailed directions on the process of using the A+ GPS Recorder for the 

purpose of conducting an on-time performance analysis of transit service.  The steps for collection of on-time 

performance data are as follows: 

1. Prior to riding the transit route turn the unit on by sliding the switch from “Off” to “Log”; a solid orange 

light will appear; when the light begins to blink the unit is ready to begin collecting data 

 

2. Board the bus 

 

3. Press the button when the bus departs from the transit stops posted in the route schedule or passes by the 

stop 

4. Continue manually operating the unit for the duration of your shift 

  

5. At the end of the shift exit the bus, and hand off the GPS unit to the next worker.  If you are the last worker 

for the day press the push button as the bus departs the stop then turn the GPS unit off by sliding the switch 

from “Log” to “Off” 

 

 

Based on empirical data the A+ GPS Recorder is able to store approximately 24 hours of data before its memory 

capacity is full.    

 

Post Processing GPS Data 

 

The process for downloading data from the GPS unit is as follows: 

1. Open the GPS Phototagger Software Program 

2. Connect the GPS unit to the computer via the mini USB cable 

3. Slide the power switch on the GPS unit to the on position 

4. Click File>Read Device Log 

5. Select the GPS track(s) of data collected 

A selected GPS track in the GPS Phototagger Software is shown below: 



 

 

The blue line represents the route of the mass transit shuttle.  The red dots along the route represent timing points, a 

transit stop where the departure time is posted by the transit operator.  The red dots are the result of manually 

pressing the push button on the GPS unit.  To export the selected GPS track: 

 Click File > Export_Track(s) 

 Choose the track(s) you want to export and click “OK” 

 Save the file in the appropriate location, give the file a meaningful name and save as type Excel File (*.csv) 

 Safely remove the GPS unit from the computer  

 Close GPS Phototagger program and open the saved file in Excel 

   Edit the Excel spreadsheet so that it contains the attributes shown below: 

 



In order to conduct an on-time performance analysis in Excel it is necessary to compute the On-time Percentage 

(OTP) which determines the Level of Service (LOS) provided by the transit agency.  The complete analysis of on-

time performance in Excel is shown below: 

 

 

It is important to note that the “OTP_Result” field reports the percentage of buses that operated on-time and the 

“LOS” field grades the level of service provided by the transit operator based on conventions set in the literature.  

The on-time performance analysis spreadsheet shown above contains formulas that automate the analysis process by 

allowing data to be copied and pasted into an analysis template that contains the formulas.  The data can then be 

dragged and automatic computation will result with the exception of the “Schedule” column.  Data entry in the 

“Schedule” column requires the analyst to compare the actual time that the bus departed the stop according to when 

the push button was pressed on the GPS unit with the time that the bus was supposed to depart according to the 

schedule.  This is a tedious and time consuming process that has the potential to introduce error and bias into the 

study because it requires the analyst to compare every row in the “Actual” column with the bus schedule.  The use 

of Automatic Vehicle Location (AVL) technology is a more efficient method of conducting an on-time performance 

analysis in terms of time and cost savings as well as improved accuracy.  As such, future studies of this nature are 

encouraged to explore the feasibility of using an AVL system. 

 

 

ON-TIME PERFORMANCE ANALYSIS FORMULAS 

 

The method of analysis for conducting an on-time performance analysis in an Excel spreadsheet template uses the 

following formulas to allow for data to be dragged and dropped into the spreadsheets for analysis.  The formulas are 

as follows: 

NOTE: Formulas contain column names for illustrative purposes.  To operationalize formulas in Excel use cell 

locations, ie: cell D2. 

 

 

Excel Formulas: 

 

Actual SEC = Actual*86400    [Note: format cell as general] 

 



Schedule SEC = Schedule*86400  [Note: format cell as general] 

 

Diff SEC =  (Actual SEC – Schedule SEC) 

 

STATUS = IF(Diff SEC<0,”EARLY”,(IF(Diff SEC>=300,”LATE”,”ON-TIME”))) 

 

COUNT EARLY = COUNTIF(1
st
 cell in STATUS column: last cell in STATUS column,”EARLY”) 

 

COUNT ON-TIME = COUNTIF(1
st
 cell in STATUS column: last cell in STATUS column,”ON-TIME”) 

 

COUNT LATE = COUNTIF(1
st
 cell in STATUS column: last cell in STATUS column,”LATE”) 

 

OTP_RESULT = COUNT EARLY Value/ COUNT TOTAL*100 

 

LOS = IF(OTP_RESULT=95-100,”A”,(IF(OTP_RESULT=90-94.9,”B”,(IF(OTP_RESULT=85-89.9,”C”,(IF(OTP-

RESULT=80-84.9,”D”,(IF(OTP_RESULT=75-79.9,”E”,(IF(OTP<75,”F”))))))))))) 

 

  

It is important to note that in order to visualize the on-time performance data in ArcGIS, additional columns must be 

added to the data table to allow for data visualization in a GIS environment.  The screenshot below illustrates what 

the Excel table should look like after the on-time performance analysis template is completed.  The appearance of 

the completed Excel table of the on-time performance analysis template is shown below. 

 

Before the on-time performance data can be visualized in ArcGIS it is necessary to append an additional three 

columns to the data table.  The screenshot below shows the addition of three columns to the table: “Early”, “On-

time” and “Late”.  These columns are created by combining the “Departure” and “Count” columns into one column 

with the data values for early, on-time and late departures duplicated in all the rows of the column.  These columns 

can easily be created by using the copy + paste function.  The screenshot below illustrates how the completed Excel 

table should appear. 



 

Now that the data has been post processed in Excel and configured for compatibility in a GIS environment, it is 

necessary to aggregate the data tables for each transit route into one data table per route.  This step is necessary for 

the purpose of data visualization in ArcGIS.  The copy + paste function can be used to aggregate the individual data 

tables into one table per transit route.  The aggregated data is now ready to be imported into ArcGIS for 

visualization and spatial analysis.  

 

Mapping Data in Arc GIS 

 

 Save the edited Excel file as “Excel 97 – 2003 (.xls format)” to the project folder 

 Open the ArcMap project file “OTP_Analysis.mxd”  

 Open ArcCatalog and navigate to the .xls table location and double click on it to view the table 

 Right click on the worksheet representing the table and select Export > to dBase (single)  

 Fill out the dialogue box as show below and give the .dbf file a descriptive name.  Save the .dbf file in the 

project folder 

 



 Open the “OTP_Analysis.mxd” project file and click on the add data button.  Navigate to the location of 

the .dbf file saved in the last step and add it to the project 

 Right click on the .dbf file and click on “Display XY Data”.  It is important to note that the X field 

represents Longitude and the Y field represents Latitude 

X = Longitude 

Y= Latitude 

 Edit the coordinate system of the .dbf file to World Geographic System 1984 (WGS 1984).  The coordinate 

system used for the street network in this project is a projected coordinate system: UTM 18N North 

American Datum 1983 (NAD 1983 UTM Zone 18N). 

 When you have finished editing the .dbf file click “Ok” and the GPS data will appear on the map as shown 

below 

The ArcMap project window shown below contains a city street network and the timing points for a metropolitan 

mass transit route that were collected using the GPS units.  

 

Now that the on-time performance data collected from the GPS units has been successfully imported into ArcMap, 

the data can be visualized and spatially analyzed. 

 

To visualize the on-time performance data in ArcMap follow these steps: 

 Double click on the “Events” data variable found in the Table of Contents  

 Select “Symbology” 

 Select “Charts” then “Stacked” 

 For the Field Selection select the fields “Early”, “On-time” and “Late” 

 Choose a color scheme that is representative of the data 

 Uncheck the box to prevent chart overlap 



 Click “Apply” to visualize the data on the map 

The Layer Properties dialogue box should be calibrated as shown below: 

 

 

Once the layer properties have been calibrated and applied the visualization of the data should appear something like 

what is shown below.  The data layers in the Table of Contents illustrate the different transit routes under 

investigation in this study.  The number of early, on-time and late departures are illustrated by using a color scheme 

that is representative of the data to help with data visualization and analysis.                  

 

 

 

 

 



 



 

 

SUGGESTIONS FOR CREATING A SUCCESSFUL SURVEY ANALYSIS 

 

 

INTRODUCTION 

 

In order to gather comprehensive information on commuting behavior and preferences, a survey needs to be 

designed.  This survey should solicit quantitative information on commuting modes, travel times and distances, 

along with demographic attributes.  In addition, qualitative questions on the quality of mass transit offerings and 

desired services should be included.  A sample survey is included in this section that can be modified to fit the needs 

of the institution. 

A process by which the survey is created and administered should first be developed.  It is advised that committee be 

formed to review and provide input on the survey formation.  Draft surveys are sent to this committee by those 

assigned to form the survey with subsequent revisions being made based on comments received.  These iterations 

should continue until a final version is deemed acceptable.   

Surveys can be administered in many forms. Recently, the use of on –line surveys has become the method of choice 

due to its relative ease of administration, low cost and ability to track and manage responses.  An initial mailing 

should be sent out to the target population (In the sample survey provided, the entire employee population of 

approximately 3,500 people  and half of the student population, about 9,000 students,  were sent this initial request).  

Reminder emails subsequently are sent to non-respondents on a weekly basis for three weeks.  This should garner an 

acceptable response rate that is demographically representative of the population as a whole. 

 

 

 

 

 

 

 

 



 

EXAMPLE OF STUDENT SURVEY 

 

 



 



 



 



 



 



 



 



 



EXAMPLE OF EMPLOYEE SURVEY 

 

 



 



 



 



 



 



 



 



 



 

 

THANK YOU AND FOCUS GROUP SOLICITATION MESSAGE 

 

Thank you for taking the UAlbany Transportation Survey! 

Your responses will help UAlbany evaluate our services, programs, and facilities related to transportation. 

Would you be willing to participate in a focus group studying this issue in the Spring? 

� Yes. 

� No, thank you. 

 

Thanks so much for your willingness to participate in a focus group next Spring! 

 

We just need to ask about your affiliation with the University, and get your contact information so we can get in 

touch with you next Spring. 

 

What is your affiliation with UAlbany? (Please select the option that comes closest to describing your affiliation.) 

� Freshman � Other Student 

� Sophomore � Faculty 

� Junior � Staff 

� Senior � Administration 

� Master's Student � Other Employee 

� Doctoral Student 

 

Please provide your first name and e-mail address so we can contact you next term. 

This information is stored in a data set completely separate from the survey data. 



First Name: _______________________________________________ 

E-mail Address: _______________________________________________ 

Thanks anyway -- we still appreciate your taking the survey! 

Please click on "submit" below to exit this page. 

After clicking on "submit," you will be re-directed to the UAlbany Green Transportation Web page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



SUGGESTIONS FOR CREATING A SUCCESSFUL FOCUS GROUP 

ANALYSIS 

 

INTRODUCTION 

 

As it is not possible to answer detailed questions through a traditional quantitative method, a qualitative supplement 

must be included, specifically in the form of open-ended interviews. The most efficient method of an open-ended 

interview, a method that facilitates obtaining answers from many subjects at a time, and one that allows for deep 

exploration of a topic, is the focus group. (Spitze, 2010). Originally developed during the late 1930‟s to counteract 

the presence of interviewer bias, focus groups often generate greater topic depth because of the non-directive 

involvement of the moderator in the group and a homogenous environment that takes away pressure to provide 

answers that are often socially unacceptable (Krueger 2000).   The following outlines suggestions for creating a 

successful focus group environment. 

 

GROUP SIZE AND COMPOSITION 

 

One of the central elements to the focus group is “full engagement” of all participants. Since beliefs and decisions 

are often created through the group process, or its “synergy”, and much less likely to occur in the traditional one-to-

one interview process, it is very important that all group members are full involved in the discussion. Group size 

plays a vital role in this engagement process. While market research-based focus groups can often succeed with 

groups numbering up to 12 or more, social scientists have found that the optimum focus group number generally 

falls between six and eight participants (Krueger, 2000). Although having well over eight participants certainly 

increases the total number of opinions given, for a variety of topics, the chance for equal participation of all 

members lessens. As group numbers grow steadily larger, shyer members will tend to remain quiet rather than speak 

in front of a large group, and more dominating members will contribute a higher percentage of the time.  

 

A balanced flow of conversation is also difficult with over eight participants. Due to the single spotlight and desire 

of many to express their points, multiple speakers, or worse yet, “side conversations” may occur (Krueger, 2000). 

While multiple speakers are particularly bad for recording purposes, side conversations are even more deadly to the 

group conversation because not everyone in the group has access to the information shared. Although no absolute 

upper limit of the focus group exists (sometimes as high as 10 or 12 for social science purposes), a great measure of 

this “group engagement” is the whisper test: if the moderator is able to hear whispers between multiple participants, 

the group is too large (Krueger, 2000). Group sizes much smaller than six are equally problematic as well. With well 

under six participants the total amount of information available is simply too limited. While it may be possible to 

maintain a useful discussion with five or four members, a group much smaller than this is generally unable to sustain 



a thoughtful conversation, independent of the constant moderator guidance, that is likely to produce wholly new 

ideas through the group process method.  

 

Topic “depth”; the uncovering of underlying beliefs about the specified topic, is the other core element to successful 

focus groups, and is perhaps even more critical than member participation. Generally in a public setting, participants 

are more inclined to give answers that are “publically acceptable” or more traditional in nature, rather than what they 

might actually believe. In this instance members commonly wish to maintain an appearance of political correctness 

and withhold any potentially offensive beliefs, which could upset other group members or the interviewer (Krueger, 

2000). It is crucial, therefore, that the focus group maintains a small, tight-knit, and comfortable setting where 

sensitive topics can be fully explored.  

 

Unlike most research groups that aim for a wide diversity of participants, they key to topic depth in focus groups is 

homogeneity. Homogeneity in the group; by ethnicity, age, gender, social class, or other demographic factors, is 

very important to building a sense of trust within the group, and allowing for frank discussion of the topic, whether 

it be sensitive or commonplace. The mood of the group should be cohesive enough that the conversation can, 

essentially, maintain itself, with the moderator playing less of an authoritative, and more of a casual-observer, role. 

While participants should generally feel comfortable with each other in the group, it is also important, though, that 

that none are closely acquainted prior to the meeting. This precludes any withholding of information, or any shared 

“secrets” (Krueger, 2000). 

 

QUESTION DEVELOPMENT  

 

Experts in the field of focus group administration also emphasize the importance of a specific order and “flow” to 

the question asked during the interview; one in which all questions should be asked, but space allowed for silence 

and contemplation, over the course of the 1hr – 1 ½ hr meeting (Spitze 2010). The general consensus for conducting 

a focus group uses a “question route”, in which a series of questions are asked in a specific order, most commonly 

general to specific. These follow five main steps: “opening questions”, to set the mood and create comfort in the 

room; “introductory questions” to introduce the topic at hand; “transition questions” to move from the general to the 

specific; and most importantly three to five “key questions”, which cover the most critical elements of the topic 

(Krueger, 2000).   

 

The interview is then generally concluded with one to two “ending questions”, summarizing the main points 

discussed. It is also vital to have many sets of questions for each topic. While one or two questions are likely to 

begin a lengthy discussion for a particular topic, this is not always the case. It is important to have several backup as 

well as probing questions, to further explore each topic (Commuri 2010).  

 

 



RECRUITING PROCESS 

 

There are a variety of both methods of, and timetables for, contacting, recruiting, and retaining perspective focus 

group participants. While emailing is certainly the easiest, cheapest, and least labor-intensive method of contact and 

retention of recruits, other methods including phone calls, word of mouth, the snow-ball effect, in person 

recruitment, and advertising are all viable forms of participant recruitment; and in fact, each one of these methods 

was utilized, with varying degrees of success, over the course of this project.  

 

Regarding online participant recruiting in particular, there are two distinct approaches that can be used; each with 

their unique strengths and weaknesses, depending on the responsiveness of the various stakeholder groups. If 

stakeholder groups are thought to be relatively responsive via email, the incremental or “batch” technique can be 

used. In this case, a small number of people are contacted and invited at a time, and no other perspective members 

are contacted until a sufficient amount of time has passed, and/or a large number of members from the initial list 

have RSVP‟d as either being able or unable to attend the meeting. The strength of this technique is that, if done 

correctly, it can yield exactly the number of participants required. With a steady recruitment process, there is no 

need to turn away any initially contacted perspective recruits. The weakness of this method, alternatively, is that, if 

not done with enough advance notice, it can have very low yields of respondents, depending on the responsiveness 

and availability of the stakeholder group.  

The other method here referred to as the “blanket” technique, employs an all-at-once strategy. In this manner a 

blanket invitation is sent to all perspective participants, with the assumption that a critical mass of participants is 

likely to contact the recruiter more quickly that the incremental approach. This technique can be used just as early as 

the batch technique, allowing more time for responses from the large number of those contacted, and is also helpful 

in situations with less lead time. The downside to this technique, of course, is that the recruiter may have to turn 

away, a large number of people that he or she initially invited, which can be perceived as somewhat unprofessional 

depending on the associated stakeholder populations.  

 

While there is no definitive contacting schedule and initial number of invitations sent in order to reach the end goal 

of six to eight participants at each focus group, some guidelines were developed for this handbook that may aid the 

online recruiting process of future focus groups. For the best results, a series of four email exchanges between the 

participant and recruiter should occur, and depending on the attrition rate of the targeted group, there should be 

approximately 14 to 26 participants that initially able to join the group upon first contact one month before the 

meeting. These figures are based on a low attrition rate of ¼ loss between each confirmation over the four weeks, 

and a high attrition rate of ½ over the same number of weeks. The final average number of 7 participants, therefore, 

climbs to between 14 and 26 or higher depending on the respective group‟s likely attrition rate. These figures only 

take into account the total number of participants that are initially able to attend the focus group. Inability to attend 

based on schedule conflicts will likely preclude at least 1/3 of those contacted from attending, and it is likely that 

another 1/3 will not return the email; so in order to truly have a comfortable base of perspective focus group 



members, it may be necessary to initially send out as many as 42 to 78 invitations, depending on the variables at 

hand.  

 

A scheduled set of email exchanges is also important for retention of perspective members. A period of four weeks 

is optimal for sending initial invitations to members. After immediately confirming those able to attend four weeks 

before the meeting, it is best to follow up with each respondent two to three weeks later. This two to three week 

period allows both parties space to reconfirm without frequent burdensome emails, and can help thin out an initially 

large respondent group. Reconfirmations three to four days before the meeting are important and those the night 

before, or day of, the meeting are particularly necessary for knowing, definitively, that the target number of 

participants will be present.  

 

Focus group marketing through brand identification and incentives are also very central elements to successful 

member recruitment. Often times small sums of money, generally in the area of $25 to $50 per member, is used to 

entice people into agreeing, and following through with their commitment, to attend a focus group (Krueger, 2000). 

While cash incentives are primarily used in market research, they are also quite common in the social sciences and 

other academic arenas. Food is also a common incentive in many focus groups. Whichever enticement is used, 

specifically mentioning the reward in the invitation to each group is essential. In order to have a successful 

marketing and advertising strategy of the study, for both participants and various interested parties, it is also useful 

to have study-identity and branding (Krueger, 2000) such as, U-Commute, and display this title throughout various 

email exchanges and signs advertising the event, and directing participants to meeting areas.  

 

SUCCESSFUL FOCUS GROUP ADMINISTRATION 

 

Some specific elements exist that are necessary for, and lead to, the administration of successful focus groups. The 

role and importance of the moderator is central to a well-run meeting (Krueger, 2000). On the one hand the 

moderator needs to have general command over the meeting structure and process: pinpointing potentially dominant 

speakers and mitigating their effect over the group through seating arrangements and other techniques; drawing 

input from less talkative or shy participants; specifying meeting guidelines and rules, and maintaining the flow of 

the conversation to be both on time and on topic. At the same time, the moderator must remain almost as a 

background figure; letting the participants do a majority of the talking, being an engaged and active listener, but 

have the ability to guide the conversation at critical moments.  

 

The moderator should also be very comfortable with the focus group topic and question route. As conversations 

often do not follow the exact outline created for the meeting, the moderator should be able to easily jump between 

topics (most successfully done though the use of labeled note cards or other tools); and also set a pace that is both 

steady, without lagging, but is also not rushed, giving lots of space to explore topics, including periods for pause and 

reflection (Commuri 2010). In case of an emergency, or inability to attend a meeting, it is also useful for the 



moderator to layout the question format with enough clarity, so that the assistant moderator or other personnel can 

run the meeting without great difficulty.  

 

The use of an assistant moderator is also quite important both for technical assistance during the meeting and for 

recording purposes. The presence of an assistant frees up the moderator from handling supportive tasks such as food 

service issues, entry or exit of participants, distribution of forms, and microphone maintenance. Assistant 

moderators are also key to the recording process. While moderators can take notes with some level of detail during 

the meeting, assistants can take extensive detailed notes during the meeting, allowing for immediate topic discussion 

following the meeting, and saving the moderator countless hours transcribing the interview. It is also important for 

both moderator and assistant to designate a private room for the event, free of extraneous sound for the recording 

process; and it is often useful to have two recorders as backup in the event that one malfunctions.  

 

Full disclosure and consent of participants is also important before initiating focus group interviews. They are 

almost always required by institutional research board‟s (I.R.B.) at colleges and universities for the conducting of 

any research based interviews, and are generally good practice for having a knowledgeable and content set of 

participants. In this study, participants were given an overview of the study in the invitation, and after an explicit 

description of the meeting outline, participants were given two consent forms to sign, or not to sign that indicated 

their willingness to be participants in the study, and their comfort with having the interview recorded and stored on 

file.  

 

Various other measures for success during the interview also exist. It is very important to select a meeting location 

that is central to as many participants as possible. Depending on the centrality of the meeting location, it is also 

useful, often times, to place signage along commonly travelled paths of the respective participant groups. Sometimes 

reservation difficulties arise when scheduling a number of consecutive meetings as well, so it is always important to 

reconfirm room reservations a number of times leading up to, and including the day of, each meeting.  
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SAMPLE FOCUS GROUP DOCUMENTS  

 

Sample Invitation 

 

Dear _______, 

 

Thank you very much for your participation in the Fall 2009 Transportation commuting survey. As you stated in 

your survey, you would be interested in participating in a follow-up discussion on your commuting preferences.  

 

I am writing to invite you to join a small group of fellow faculty for a lunchtime discussion to help us learn more 

about this topic  

The „U-Commute focus groups‟ will provide lunch at the Campus Center 375, and staff and student members from 

the Planning Department will facilitate the conversations. 

 

The lunch discussion will take place on _________ from 12:00 to 1:30 PM, and will be located in the Patroon 

Room. A free catered lunch will be provided. This group is dedicated solely to fellow faculty members who were 

interested in follow up conversations regarding the transportation survey conducted in the Fall of 2009 

 

If you are interested in participating, please contact ________ either by phone at ________ or by e-mail at 

_________________ 

I hope you can join us over lunch and share with us your opinions and experiences. Thanks in advance for your 

input! 

 

Yours Sincerely, 

_____________________ 

Research Assistant 

Department of Geography and Planning 

University at Albany-SUNY  

Albany, NY 12222  

PH: ___________________ 

 

 



Sample Focus Group Questions 

 

Focus Group Questions (Female Off Campus) 

Hi everyone.  

 

Welcome to our focus group on commuting to school, your preferences, and alternative methods of transportation 

 

I‟m ______ and I‟ll be your moderator today. Also this is _____ and he‟ll be our assistant moderator.  

 

Before we go into our discussion I‟ll just say a few words about why we are here today and what this process is 

going to be like just to reemphasize what was in the emails you were sent.  

 There is an ongoing research project looking at alternative methods of transportation for Suny students staff 

and faculty, and we wanted to get a more in depth look at peoples ideas than just the survey that was sent 

around. So that is what we are doing today in a more focused group, or focus group.  

 We will have about 1 ½ hours for our discussion. If we end more quickly that is fine and if people want to 

stick around that is fine also, although we will not be recording after that time.  

 We will not be stopping for breaks, so if you need to go to the bathroom please feel free to go at any time, 

grab food etc. 

 I want to let you know that we are recording these sessions on a digital recorder so we can take notes from 

them later. Everything said here though is confidential and we will not attach your name to the 

transcriptions,  so feel free to be as candid as you want.  

 

I just want to go over a couple of ground rules before we start also.  

 One person at a time should be talking. This is both out of respect but also it makes it difficult to make out 

5 voices at once on the recorder.  

 So please no side conversations 

 Also most of the time we will not have to go in order, but if I see you not talking at all I may pick on you  

 Are there any other rules that you think we should have? 

Ok, so as kind of an introduction, why don‟t we go around the room and say our name, the city we‟re from and what 

our major (department) is.  

 



Now we‟re going to get into a few of the questions that we are here today to talk about. I want to start by talking 

about the overall transportation system here at SUNY 

1. Overall quality of U-Albany transportation  

How do you feel the University‟s transportation system works for you, or doesn‟t work for you? 

Have you had any major problems since the time you‟ve been here? 

2. PARKING: 

PARKING: What are your thoughts on the parking situation? 

Is there enough? 

The university is considering a preferential parking for different kinds of drivers. What do you think preferential 

parking for hybrids? carpoolers? 

What is your opinion on carpooling?  

What would make parking here so difficult that you wouldn‟t want to drive at all? What about if they raised the 

parking fees to $500, $1000 a year for example? Or there was even more congestion? 

3. Bus 

What is your opinion on the bus system? 

Do you have friends that regularly use the bus? Do you use the bus yourself?  

What are the major problems with the bus, if any? 

Would you be more likely to use the bus if you could go anywhere free? 

Would you use the bus more if the bus had internet? Was a hybrid? 

When do you think you would actually choose to take the bus? 

Some people in the survey seemed interest in getting some kind of rewards for using the bus. What do you think 

about that idea? What kinds of rewards would interest you? 

Do you think it would be useful to have a notifier on your IPhone (for example) that told you how close a bus was? 

Do you ever use the shuttle? How is that system working for you? 

 



4. Carpooling 

What is your opinion on carpooling?  

Is there anything about it that is unappealing?  

When do you think you would actually choose carpooling over driving alone? 

Would you be more likely to carpool if you got preferred parking close to campus just for carpoolers? 

What about the idea of Zip-car, (where you can rent a car cheaply for a long term or short term)? 

5. Biking 

Do you own a bike? 

Have you ever biked to campus?  

Some people in the survey talked about not feeling safe biking to campus; what do you think it would take to get 

you to feel safer biking to campus? 

Some people in the survey talked about wanting nice bike facilities on campus. What kinds of amenities do you 

think it would be nice to have around here? 

What do you think about the idea of a bike share for use on campus or ones that you could take home? 

6. Bigger Trips 

How do you get to and from home at the beginning and end of the semester?  

Do think it would be a good idea for there to be coordinated pickups at the airport or buses to NYC? 

7. Better Mileage New Car 

The university is thinking about a program where they could get a good discount on a bulk purchase of hybrid cars. 

What do you think about this idea? Would you be interested in getting a hybrid or a used car with better fuel mileage 

if the university could get you a good discount toward that?  

8. Anything else 

Are there any other ideas you have about how to make commuting to campus more environmentally friendly? 

Thank you all very much for coming 

 



Focus Group Questions (Tuesday – Male Off Campus) 

Hi everyone.  

Welcome to our focus group on commuting to school, your preferences, and alternative methods of transportation 

I‟m _____ and I‟ll be your moderator today. Also this is _______ and he‟ll be our assistant moderator.  

Before we go into our discussion I‟ll just say a few words about why we are here today and what this process is 

going to be like just to reemphasize what was in the emails you were sent.  

 There is an ongoing research project looking at alternative methods of transportation for Suny students staff 

and faculty, and we wanted to get a more in depth look at peoples ideas than just the survey that was sent 

around. So that is what we are doing today in a more focused group, or focus group.  

 We will have about 1 ½ hours for our discussion. If we end more quickly that is fine and if people want to 

stick around that is fine also, although we will not be recording after that time.  

 We will not be stopping for breaks, so if you need to go to the bathroom please feel free to go at any time, 

grab food etc. 

 I want to let you know that we are recording these sessions on a digital recorder so we can take notes from 

them later. Everything said here though is confidential and we will not attach your name to the 

transcriptions,  so feel free to be as candid as you want.  

 

I just want to go over a couple of ground rules before we start also.  

 One person at a time should be talking. This is both out of respect but also it makes it difficult to make out 

5 voices at once on the recorder.  

 So please no side conversations 

 Also most of the time we will not have to go in order, but if I see you not talking at all I may pick on you  

 Are there any other rules that you think we should have? 

 

 

Ok, so as kind of an introduction, why don‟t we go around the room and say our name, the city we‟re from and what 

our major (department) is.  

Now we‟re going to get into a few of the questions that we are here today to talk about. I want to start by talking 

about the overall transportation system here at SUNY 

1. Overall quality of U-Albany transportation  

How do you feel the University‟s transportation system works for you, or doesn‟t work for you? 



Have you had any major problems since the time you‟ve been here? 

2. PARKING 

PARKING: What are your thoughts on the parking situation? 

Is there enough? 

PARKING: The university is considering a preferential parking for different kinds of drivers. What do you think 

preferential parking for hybrids? carpoolers? 

PARKING: What is your opinion on carpooling?  

PARKING: What would make parking here so difficult that you wouldn‟t want to drive at all? What about if they 

raised the parking fees to $500, $1000 a year for example? Or there was even more congestion? 

3. BUS 

BUS: What is your opinion on the bus system? Do you have friends that regularly use the bus? Do you use the bus 

yourself?  

What are the major problems with the bus, if any? 

BUS: Would you be more likely to use the bus if you could go anywhere free? 

Would you use the bus more if the bus had internet? Was a hybrid? 

BUS: When do you think you would actually choose to take the bus? 

BUS: Some people in the survey seemed interest in getting some kind of rewards for using the bus. What do you 

think about that idea? What kinds of rewards would interest you? 

BUS: Do you think it would be useful to have a notifier on your IPhone (for example) that told you how close a bus 

was? 

BUS: Do you ever use the shuttle? How is that system working for you? 

4. CARPOOLING 

CARPOOLING: What is your opinion on carpooling?  

Is there anything about it that is unappealing?  

CARPOOLING: When do you think you would actually choose carpooling over driving alone? 



CARPOOLING: Would you be more likely to carpool if you got preferred parking close to campus just for 

carpoolers? 

CARPOOLING: What about the idea of Zip-car, (where you can rent a car cheaply for a long term or short term)? 

5. BIKING 

BIKING: Do you own a bike? 

Have you ever biked to campus?  

BIKING: Some people in the survey talked about not feeling safe biking to campus; what do you think it would 

take to get you to feel safer biking to campus? 

BIKING: Some people in the survey talked about wanting nice bike facilities on campus. What kinds of amenities 

do you think it would be nice to have around here? 

BIKING: What do you think about the idea of a bike share for use on campus or ones that you could take home? 

6. BIGGER TRIPS 

BIGGER TRIPS: How do you get to and from home at the beginning and end of the semester?  

BIGGER TRIPS: Do think it would be a good idea for there to be coordinated pickups at the airport or buses to 

NYC? 

7. BETTER MILEAGE CAR 

BETTER MILEAGE CAR: The university is thinking about a program where they could get a good discount on a 

bulk purchase of hybrid cars. What do you think about this idea? Would you be interested in getting a hybrid or a 

used car with better fuel mileage if the university could get you a good discount toward that?  

8. ANYTHING ELSE 

ANYTHING ELSE: Are there any other ideas you have about how to make commuting to campus more 

environmentally friendly? 

Thank you all very much for coming 

 

 


